Quick Start Guide to

Climate Change Adaptation Tool for Transportation:

Application to the Mid-Atlantic Region

CCATT: Mid-Atlantic

Michelle Renee Oswald
University of Delaware
Based on Ph.D. Dissertation, Development of a Decision Support Tool for Transportation Adaptation Response to Climate Change
Spring 2010
# QUICK START GUIDE TO CCATT: Mid-Atlantic

## Table of Contents

**Background** ................................................................................................................................. 3

**Introduction** ............................................................................................................................................... 3

**Using CCATT: Mid-Atlantic** ........................................................................................................... 4

- Page 1: Background ............................................................................................................................ 4
- Page 2: Introduction ............................................................................................................................ 4
- Page 3: Agency Info ............................................................................................................................ 5
- Page 4: Scenario Analysis .................................................................................................................. 5
- Page 5: MAGICC Application ........................................................................................................... 6
- Page 6: Scenario Analysis Flowchart ................................................................................................ 7
- Page 7: Robustness Curves ................................................................................................................ 8
- Page 8: Adaptive Capacity ................................................................................................................ 8
- Page 9: Regional Impacts .................................................................................................................. 8
- Page 10: Jurisdictional Impacts ........................................................................................................ 9
- Page 12: Strategies for Existing ......................................................................................................... 11
- Page 13: Inventory of Proposed ....................................................................................................... 13
- Page 14: Strategies for Proposed ..................................................................................................... 13
- Page 15: Mitigation Evaluation ......................................................................................................... 13
- Page 16: Strategies for Mitigation .................................................................................................... 14
- Page 17: Monitoring Plan ................................................................................................................. 14
- Page 18: Summary Report ............................................................................................................... 15

**Contact** .............................................................................................................................................. 15

**References** ......................................................................................................................................... 15
Background
Scientific evidence on climate change and the potential for serious global impact is now stronger than ever (Stern, 2006). The Intergovernmental Panel on Climate Change (IPCC) released a statement in the Fourth Assessment Report that there is a ninety percent probability (very high confidence) that greenhouse gas emissions produced by human activities have caused most of the observed global warming since the mid-twentieth century (IPCC, 2007).

A growing concern facing the transportation sector in the United States is the potential impact of climate change on land transportation. As scientific evidence on climate change continues to support the relationship between anthropogenic activities and global warming, greenhouse gas concentrations continue to rise at a rate of more than 2 parts per million each year (Stern, 2006).

Currently the United States is the largest emitter worldwide, with transportation accounting for one third of carbon dioxide emissions (Ewing et al., 2008). Therefore, much of the discussion and efforts related to transportation and climate change is focused on mitigation and reducing transportation’s contribution to climate change (Valsson and Ulfarsson, 2009).

While mitigation efforts are essential to slowing the threat of climate change, adaptation practices to build resilience and protection from impacts should be accelerated (Stern, 2006). Mitigation efforts such as setting limits on emissions will not be sufficient, or timely enough, to avoid all potential impacts of climate change (Pew Center on Global Climate Change, 2009). Therefore, in order to prepare and protect societies, economies, and the environment, adaptation efforts are required.

Introduction
The Climate Change Adaptation Tool for Transportation (CCATT) serves as a foundation for the integration of climate change adaptation into transportation planning. It is based on the universal methodology developed in the dissertation, Development of a Decision Support Tool for Transportation Adaptation Practices in Response to Climate Change. The step-by-step process is applied to the Mid-Atlantic coastal region (CCATT: Mid-Atlantic) to serve as an example of how to implement this decision support tool within long range transportation planning for a specific region.

The Microsoft Excel™-based tool includes a scenario analysis along with four major components of adaptation planning:

1. Evaluation of adaptive capacity and impact assessment.
2. Inventory of existing transportation facilities to identify infrastructure “at-risk” to climate change impacts.
3. Assessment of proposed project to eliminate potential risk from climate change impact.
4. Evaluation of existing mitigation practices to identify supporting adaptation efforts.

The results of CCATT include information regarding the regional and jurisdictional impacts, climate change scenarios and their associated expected value, potential adaptation strategies to address existing and proposed infrastructure, and adaptation strategies in support of mitigation.
This tool is designed to be used by transportation planning agencies such as Metropolitan Planning Organizations and Department of Transportation agencies. The agency should complete each page of the tool by entering as much information about their jurisdiction as possible. Information should only be entered in the YELLOW cells. If the cell is not yellow, then no information is necessary. If information is unavailable or inaccessible, the tool can still be completed based on the information provided. It is suggested than a one month application period be used when implementing the tool. In other words, the agency should collect as much information as possible within that one month timeframe and then create a list of future data needs for the remaining inputs.

When data is collected from outside of the agency, it should be documented next to the data input as a reference for future applications. Also, any entries that include assumptions should be noted (such as an input only pertaining to a portion of the jurisdiction). However, it is strongly recommended to gather missing data whether it means collecting it in-house or contacting other agencies within the jurisdiction.

**Using CCATT: Mid-Atlantic**

**CCATT: Mid-Atlantic** is a Microsoft Excel™-based tool that allows for a user-friendly format and a simplistic method for data entry. Within the tool, each excel page or “tab” represents a step in the process of evaluating transportation adaptation. To complete the tool, the user should proceed through the 18 steps by starting with Page 1 and finishing with Page 18 of the tool. The 18 pages include: Background, Introduction, Agency Info, Scenario Analysis, MAGICC Correlation, Scenario Analysis Flowchart, Robustness Curves, Adaptive Capacity, Regional Impact Assessment, Jurisdictional Impact Assessment, Inventory of Existing, and Strategies for Existing, Inventory of Proposed, Strategies for Proposed, Mitigation Evaluation, and Strategies for Mitigation, Monitoring Plan, Summary Report. Each step (page) of the tool is described in detail in terms of its purpose as well as its use from an agency perspective.

**Page 1: Background**

The “Background” page introduces the issue of climate change and the need for adaptation integrated into long range transportation planning. **This page does not require any input.**

**Page 2: Introduction**

The “Introduction” page summarizes the purpose of the tool and its application to the Mid-Atlantic region as well as the four main components addressed. The figure below displays the four components and how they contribute to adaptation planning. **This page does not require any input.**
**Page 3: Agency Info**

The “Agency Info” page requires inputs on agency information. Enter responses to the following questions: current year, agency name, jurisdictional boundaries, region (using a drop-down menu), state(s) that the agency oversees, funding sources, and frequency of Long Range Transportation Plan updates. For the question regarding region, since the tool is developed specifically for the Northeast and Mid-Atlantic, if a value anything other than “Northeast and Mid Atlantic” is entered, then an error message is shown as “INVALID- tool does not apply!” If this is the case, the tool specific to the Mid-Atlantic should not be applied. If an agency falls into more than one region, the region in which the majority of the jurisdiction falls should be selected. The following is a screenshot of this page to represent the typical format of each worksheet.

![Agency Info screenshot](image_url)

**Page 4: Scenario Analysis**
The “Scenario Analysis” page is the introduction to the next three pages which all relate to an analysis of the possible climate change scenarios based on the agency’s planning horizon, the current timeframe, the possible severity of climate change, and potential actions that can be implemented.

Enter responses to the following based on agency information at the time of the analysis:

- **Discount factor** - takes into account that a climate change impact occurring in the present holds a different value than if it occurs in the future. This value is used as the “interest rate” when calculating the difference in expected value in the future versus the present.
- **Probability of success values for mitigating and adapting** - the likelihood that the agency will succeed in taking that specific action. Using a qualitative scale of Not Successful (0) to Extremely Successful (1.0) shown in the tool Error! Reference source not found., determine the probability of success for both mitigation and adaptation activities for your agency. Enter the value using the drop down menu.
- **Planning horizon for present, short, and long term** - the years associated with the present, short, and long term timeframes.
- **Outcome acceptance threshold** - agency’s acceptance of a specific level of impact used to determine the expected value critical. Using a scale from -3 to 3 (shown in the tool Error! Reference source not found.), determine the appropriate level of acceptance for your agency, which is used to calculate the minimum expected value. Enter the value using the drop down menu.

This concludes the inputs required for Page 4.

The remaining inputs (initial (present), short and long term probability values) are automatically entered once information is entered in the next excel tab called “MAGICC Application”. The probability values represent the likelihood of being in each state of severity based on the results from running MAGICC. The results from MAGICC allow for inputs to the following scenarios:

- Present- Do Nothing
- Short Term- Do Nothing and Mitigate
- Long Term- Do Nothing/Do Nothing, Do Nothing/Mitigate, and Mitigate/Mitigate

The remaining scenarios, which those including Adaptation and “Both”, are based on assumptions for the transition from one level of severity to another since MAGICC does not address adaptation.

The probability values take into account the risk of climate change impact without accounting for the probability of success of the intended action and are later combined with the probability of success values to determine the overall probability of being in each state.

**Page 5: MAGICC Application**

The “MAGICC Application” page describes the process of downloading the free MAGICC tool from [http://www.cgd.ucar.edu/cas/wigley/magicc/](http://www.cgd.ucar.edu/cas/wigley/magicc/) in order to determine probabilities for the scenario analysis (parts 5-7 on Page 4). Download the free tool, MAGICC/SCENGEN, and run scenarios using the following steps. Refer to User's Manual (Wigley, 2008) for additional assistance. The yellow cells indicate values that require input. Note: If necessary, the agency can
bring in an expert to complete the climate models required for this page if there is no current expertise in-house.

Once the tool is downloaded, the follow the steps to calculate the scenario analysis inputs:

1. Click on Edit > Emission Scenarios and set the reference case to P50 and the policy case to a specific emissions scenario that represents your agency's mitigation plan. If you need assistance with picking an emissions scenario, use the "Help" button which explains the scenarios in detail.
2. Click on Edit > Model Parameters and update the parameters based on the latest International Panel on Climate Change Assessment Report (http://www.ipcc.ch/). *Note for CO2 Emissions use the High, Med, Low options which are associated with 1.8, 1.1 and 0.4 Gigatons of Carbon. If unable to get updated data, use the default parameters. Enter any changes in the appropriate cell below.
3. Click on Run > Run Model.
4. Once it is finished running, click View > Graph: Temperature
5. Complete reference case analysis by highlighting only "Ref. range" and "Ref. best". Deselect all other outputs.
6. Locate the present time frame (current year + present time horizon) along the x-axis and determine the change in temperature from the "best guess" (line) for year 2010 (NOT 1990!).
7. Determine the probability of each consequence value based on the change in temperature as shown in the example below.
8. Repeat same process for Short and Long Term Time Frame for the "Do Nothing Scenario" which is equivalent to the base case scenario (P50) using the appropriate years and the appropriate table for threshold impacts.
9. Complete policy case analysis by highlighting only "Pol. range" and "Pol. best". Use steps 7, 8, and 9 to calculate the Short and Long Term Time Frame for the "Mitigate/Mitigate" scenario based on your agency's mitigation policy plan.
10. For the Do Nothing/Mitigate scenario calculate the difference between the upper bound temperature change for Do Nothing Short Term and the Mitigate Short Term. Then add the difference to the upper bound temperature change for the Mitigate/Mitigate scenario.

Using these directions, input for six scenarios can be evaluated by doing one model run in MAGICC. The base case scenario (P50) should be selected to represent the “Do Nothing” scenario and an emissions scenario from the library in MAGICC should be selected to represent the “Mitigation” scenario. Once the scenarios are run simultaneously, the output results for change in temperature can be used to determine the probability of being in each severity state. The probabilities associated with each timeframe and scenario can be input and then the values automatically update in the previous tab “Scenario Analysis”. The probabilities calculated from the MAGICC application become the probability values for the scenario analysis.

Page 6: Scenario Analysis Flowchart
The “Scenario Analysis Flowchart” page does not require any input and is used simply as a visual display of how the user inputs from the “Scenario Analysis” and “MAGICC Application” pages are integrated into the analysis. The flowchart displayed is the “original” scenario without any uncertainty analysis included. In addition to the original scenario there are
20 pages that are hidden within the file where each scenario is evaluated based on both an under and over estimation from +1 to -1 using increments of 0.1. Also, there are 20 additional pages that tie the expected value results of the flowchart to the final output displayed in the following page. To view these pages, right click on the page tag and select unhide to display a specific page.

**Page 7: Robustness Curves**
The “Robustness Curve” page displays the results of the scenario analysis based on the previous input values as well as the embedded robustness analysis. The robustness curves represent the overall expected value for each type of action taken. More specifically, they represent the expected value for each scenario (Do Nothing, Mitigate, Adapt, or Both) as a function of the horizon of uncertainty (from -1 to +1 with an increment of 0.1) as an overestimation and underestimation of the original values. Therefore, the higher the expected value, the worse the outcome associated with that scenario. The Expected Value critical (red line) is the threshold at which the scenarios below are unacceptable. The user can interpret the graph by determining the types of action required to allow for an acceptable outcome. There is a table that displays which scenarios are acceptable or unacceptable based on their relationship to the Expected Value critical line.

This page requires only one input which is the entry of the scenario(s) that fall below the red line, indicating that these types of action are unacceptable based on the agency’s outcome acceptance threshold. This information can be found either in the table or on the graph. If all scenario options fall above the “red line” (including the Do Nothing/Do Nothing scenario) it is still recommended to complete the tool on a yearly basis for a proactive approach to climate change action. It is assumed that over time, probabilities and expected values may change and being prepared and knowledgeable about existing and proposed vulnerabilities can prevent future impacts.

**Page 8: Adaptive Capacity**
The “Adaptive Capacity” page helps to identify potential boundaries or barriers preventing the agency from adapting to climate change. This page requires (yes/no) inputs on whether or not there are agency barriers relating to governance, social structure, or creating information. These questions are based on the barriers listed in Adaptation: Barriers to Adaptation (2009). The total number of barriers is provided and it is recommended to evaluate why each barrier exists and find ways to address it as appropriate before moving onto the next page.

**Page 9: Regional Impacts**
The “Regional Impacts” page automatically indicates which types of climate change impacts based on the inputs in the “Agency Information” page, the agency is vulnerable to. The red “X’s” indicate that there is the potential for an impact to occur based on the agency’s regional location. The impacts and associated regional breakdown are based on the research of the Center for Integrative Environmental Research at the University of Maryland (CIER, 2007).
There is only one input required on this page which is any specific regional impacts that may not already be listed. Since the tool is specific to the Mid-Atlantic, the results red “X’s” should always indicate increases in very hot days and heat waves, rising sea level, and increases in intense precipitation events. If not, then the entry on the “Agency Information” page is either incorrectly entered or the entry is invalid and the tool should not be applied to that agency.

**Page 10: Jurisdictional Impacts**
The “Jurisdictional Impacts” page requires “yes/no” responses (using a drop down menu) to questions along with some numerical responses regarding possible impacts based on local geographic characteristics or vulnerable components within the jurisdiction. Local characteristics include following: presence of tunnels, bridges, roadways, railways, rail stations, toll facilities, pedestrian walkways, and cycling facilities. There is also a section to input any additional jurisdictional impacts that may not already be included in the previous questions. The numerical entries are used as a reference for calculating percentages of facilities at-risk in Page 12, “Strategies for Existing”.

**Page 11: Inventory of Existing**
The “Inventory of Existing” page provides an assessment of the existing facilities that are vulnerable to potential climate change impacts. Since the tool is specific to the Mid-Atlantic, the three impacts, specified as outputs in Page 9 of the tool (#1-increases in very hot days and heat waves, #2- rising sea level, and #3-increases in intense precipitation events), are used as impact categories for the inventory. When developing the tool for other regional locations, the appropriate impacts need to be included as specified in the table on Page 9. Each of the impact categories are described along with the appropriate inputs.

**Impact #1: Increases in Very Hot Days and Heat Waves**
For the impact of rising temperatures and increased heat waves, one of the major issues associated with transportation is stress on pavements and road decks (National Research Council, 2010). Therefore, an inventory is recommended based on the material types for roadways (highways, arterials, local, and collectors) as well as vulnerable pavement locations. The roadway material types are divided into five categories: asphalt (Hot Mix-HMA), concrete (Portland Cement-PCC), composite (HMA and PCC), permeable pavement, and other (WSDOT, n/d). Once a mileage is entered, then the percentage is automatically calculated. The purpose of entering these values is so that the user can begin to assess heat-resistant pavement materials. For example, longer periods of extreme heat may compromise pavement integrity such as softening asphalt (TRB Special Task Force on Climate Change and Energy, 2008). Therefore, conducting an inventory provides information for the following page, “Strategies for Existing”.

In addition, to material type, vulnerable areas are addressed as well. Enter numerical responses to the following information:

- Number of outdated expansion joints- defined as joints, meant to aid in expansion or contraction of the roadway material, that are in need of repair.
- Vulnerable pavement locations- identified by using the International Roughness Index (IRI) which is the method used in the Highway Performance Monitoring System (FHWA, 2008). Based on this index, the threshold for an unacceptable pavement condition is
greater than 170 inches/mile. Therefore, the mileage of roadways greater than 170 inches/mile should be input as well as mileage between 95-170 inches/mile to determine roadways that are in “fair” and “poor” condition.

- Miles of rail buckling-defined as instability of the rail track as a result of compressive forces generated by heat expansion.

**Impact #2: Rising Sea Level**

For the impact of sea level rise, use Geographic Information Systems (GIS) to complete an inventory of at-risk infrastructure based on inundation layers. Using GIS, 5 steps are suggested in order to analyze vulnerable facilities at-risk to sea level rise. The steps are as follows:


2. **Create Inundation Layers**- Using GIS, develop inundation layers for 0.5, 1, 1.5, and 2 meters or gather from state agency if previously developed. Use ICF International Report (2007) as a guide for creating the layers and conducting the inventory.

3. **Determine Vulnerable Areas**- Using GIS, determine areas that will be vulnerable up to 2 meter sea level rise.

4. **Divide into profile areas**- Using GIS, divide the vulnerable area into smaller profile areas in order to analyze in detail.

5. **Analyze Profile Areas**- Complete the following table for each individual profile area and enter the cumulative values representing the entire jurisdiction. If information is unavailable or not applicable to the region then enter "0" for that input.

It is suggested to use the ICF International Report (2007) as a guide throughout the entire process as it provides a step-by-step method for conducting this analysis.

If information is not available or not applicable to a jurisdiction, enter zero as the value. These values serve as a foundation for determining which facilities should be addressed and in what priority, discussed in the following page of the tool. In addition to the tabular input, a graph of the existing vulnerable facilities is automatically updated based on user input. The figure is simply used as a visual that allows the user to assess which types of facilities are more vulnerable than others.

**Impact #3: Increases in Intense Precipitation Events**

For the impact of increases in intense precipitation events, a similar process as Impact #2 is used to determine facilities vulnerable to various levels of storm surge. Even though increased storm surge is tied to increases in sea level rise, it is also a result of increased precipitation events (Jacob et al., 2000). Therefore, a similar approach of creating storm surge layers is used for the impact of increases in intense precipitation events.
In order to correlate storm surge with a precipitation event, the equivalent Saffir-Simpson scale for extreme events is used. Saffir-Simpson scale is a classification for intense precipitation events including hurricanes, tropical depressions, and tropical storms (NOAA, 2009). It includes five categories of storms based on wind, storm surge and additional factors such as pressure. For the purposes of this tool, only surge height is used and it is acknowledged that the characteristics (different combinations of storm forward speeds, landfall locations, storm tracks, storm sizes, storm intensities, and astronomical tides) that go into storm surge modeling, such as NOAA’s SLOSH model, are not included (NOAA/National Weather Service, 2010). The storm surge values represent levels of inundation during a storm event and therefore, can be used as the layers for an inundation evaluation. It is important to note, that for the purposes of analyzing the Mid-Atlantic region, Category 5 storms can be eliminated as there are highly unlikely in the northern latitude (Jacob et al., 2000). However, if the tool is created for a region located in the south, then it should be included. Also, since the storm surge heights are represented in feet, they are converted to meters for the simplicity of using the same units throughout the entire inventory analysis. The upper bound of each category storm was converted to meters and then rounded to the nearest half meter. Therefore, the following storm surge heights are used:

- Category 1- 1.5 meters
- Category 2- 2.5 meters
- Category 3- 3.5 meters
- Category 4- 5.5 meters

Similar to Impact #2, it is recommended to use Geographic Information Systems (GIS) to complete an inventory of at-risk infrastructure based on storm surge layers. Using GIS, 5 steps are suggested in order to analyze vulnerable facilities at-risk to storm surge events. The steps are as follows:

1. **Gather Data**- Collect GIS files of jurisdictional boundaries, housing data, and existing transportation facilities and plot in GIS (see step #1 in Impact #2 as reference).
2. **Create Precipitation Inundation Layers**- Using GIS, develop inundation layers for 1.5, 2.5, 3.5, and 5.5 m or gather from state agency if previously developed.
3. **Determine Vulnerable Areas**- Using GIS, determine areas that will be vulnerable up to 5.5 meter sea level rise.
4. **Divide into Profile Areas**- Using GIS, divide the vulnerable area into smaller profile areas in order to analyze in detail.
5. **Analyze Profile Areas**- Complete the following table for each individual profile area and enter the total values representing the entire jurisdiction. The 1.5 meter values are automatically updated from the sea level rise analysis.

For step 5, values should be entered in the table based on the four storm surge layers. Once the vulnerable facilities are input into the table a graph displaying the results automatically updates.

The figure is simply used as a visual that allows the user to assess which types of facilities are more vulnerable than others.

**Page 12: Strategies for Existing**
The “Strategies for Existing” page provides adaptation strategies for addressing the vulnerable facilities identified in the inventory on Page 11. Each of the three impact categories used in the inventory are used to divide up the adaptation strategies based on the three impacts specific to the Mid-Atlantic (#1-increases in very hot days and heat waves, #2-rising sea level, and #3-increases in intense precipitation events). Each of the impact categories are described along with the recommended strategies and appropriate user inputs.

**#1-Increases in Very Hot Days and Heat Waves**
For impact #1, the recommended strategies are based on the input values for the inventory of pavement materials and vulnerable areas. Where appropriate, the values input into the inventory on Page 11 are automatically provided next to the relevant adaptation strategy. In addition, the percentage is calculated based on the total for that facility type as entered in Page 10, “Jurisdictional Impacts”. This page is meant to provide recommendations and therefore, there are **no inputs are required for Impact #1 on Page 12.**

**Impact #2: Rising Sea Level**
For the impact of sea level rise, a list of adaptation activities is provided as recommendations for how to address the vulnerable facilities identified in the inventory. The list of adaptation activities is primarily drawn from the *Adapting to the Impacts of Climate Change* (National Research Council, 2010).

In addition to providing a list of adaptation strategies for sea level rise, it is recommended to address facilities that are vulnerable to sea level rise through the various adaptation activities listed above based on the following facility inundation order: 0.5, 1, 1.5, and 2 meters. The number of facilities that fall into each inundation range are automatically provided based on the inputs in the inventory. For each inundation layer, the calculations are based on the number of facilities that fall into the 0.5 meter inundation layer, then the number of facilities that fall into the 1 meter inundation layer that are not already included in the 0.5 meter inundation layer, and so on. By reporting only additional facilities inundated at each level, once a facility is accounted for at a higher priority level (lower), it is not readdressed again.

The only information required is entering the name of the facilities associated with the input value. By distinguishing the facility name or location, the highly vulnerable facilities can be identified throughout the inundation layers.

**Impact #3: Increases in Intense Precipitation Events**
For the impact of increases in intense precipitation events, a list of adaptation activities is provided in relation to increased precipitation and storm surge. The list of adaptation activities is primarily drawn from the *Adapting to the Impacts of Climate Change* (National Research Council, 2010).

In addition to providing a list of adaptation strategies for increases in intense precipitation events, it is recommended to address facilities that are vulnerable to this impact through the various adaptation activities listed above based on the following facility inundation order: 1.5, 2.5, 3.5, and 5.5 meters (which are correlated to the storm surge heights for the Saffir-Simpson scale. The number of facilities that fall into each storm surge range are automatically provided
based on the user inputs entered in the inventory. For each storm surge layer, the calculations are based on the number of facilities that fall into the 1.5 meter storm surge layer, then the number of facilities that fall into the 2.5 meter storm surge layer that are not already included in the 1.5 meter storm surge layer, and so on. By reporting only additional facilities at each level, once a facility is accounted for at a higher priority level (lower), it is not readdressed again.

The only information required is to enter the name of the facilities associated with the input value. By distinguishing the facility name or location, highly vulnerable facilities can be identified across storm surge layers.

**Page 13: Inventory of Proposed**
The page “Inventory of Proposed” allows the user to assess the proposed facilities that are vulnerable to potential climate change impacts. This page is almost identical to Page 11, “Inventory of Existing” however, this page requires input values relative to proposed projects or future facilities to be developed rather than existing.

The same three Mid-Atlantic impacts are used as categories: #1-increases in very hot days and heat waves, #2-rising sea level, and #3-increases in intense precipitation events. For impacts #2 and #3, the same process is used as discussed previously. Impact #1 has a slight difference since “vulnerable areas” does not directly apply to proposed facilities. Therefore, the input for vulnerable pavement, number of outdated expansion joints, and miles of rail buckling is not included. The only input is pavement materials which pertains to new projects and improvement projects where the pavement material would change. Besides this one difference, the page is identical to the “Inventory of Existing”. For more in depth explanation of this page refer to the description of inputs for Page 11.

**Page 14: Strategies for Proposed**
The “Strategies for Proposed” page provides adaptation strategies for addressing the vulnerable facilities identified in the inventory on Page 13. Each of the three impact categories used in the inventory are used to divide up the adaptation strategies based on the three impacts specific to the Mid-Atlantic (#1-increases in very hot days and heat waves, #2-rising sea level, and #3-increases in intense precipitation events). The strategies for impacts #2 and #3 are identical to those listed in Page 12, “Strategies for Existing” however, they are meant to be focused specifically on future facilities. The strategies provided for impact # 1 slightly differ due to the exclusion of the input for “vulnerable areas. The strategies provided for impacts #2 and #3 in relation to proposed facilities are identical to those in Page 12, “Strategies for Existing”.

The only user input required is entering the name of the facilities associated with the input value. By distinguishing the facility name or location, highly vulnerable facilities can be identified across inundation/storm surge layers.

**Page 15: Mitigation Evaluation**
The “Mitigation Evaluation” page allows the user to evaluate the agency’s existing mitigation actions implemented within the jurisdiction. There are a series of “yes, no, N/A” (using a drop-down menu) questions regarding specific mitigation strategies.

The strategies are divided into two main goals for mitigation: reduce energy consumption and reduce vehicle miles traveled, which was based on the major goals included in the Reducing Transportation Energy Use Workgroup Report (DNREC, 2009). Under these two goals, there are two categories; Goal #1: (a) Vehicular-Fuel Efficient and Alternative Fuels and (b) Materials and Operations, Goal #2: (a) Mobility Demand Management and (b) Modal Alternatives. Within each category, there are list of questions that the user completes based on the current mitigation progress of the agency or surrounding agencies. Enter a response for each one of these questions.

There is also a location for entering any other mitigation-related actions that are being implemented by the agency or in conjunction with other agencies.

Page 16: Strategies for Mitigation

The “Strategies for Mitigation” page provides a list of adaptation strategies that directly correlate with the list of questions asked on Page 15, “Mitigation Evaluation”. There is a column of mitigation actions along with the response from Page 15 (yes, no, N/A) that automatically updates and then a column of the associated adaptation actions related to that mitigation strategy. For example, for the first mitigation activity question of whether the agency is supporting alternative fuels, the adaptation strategy is to “design, plan, and develop alternative fuel infrastructure such as battery stations, biofuel fueling stations, etc.”

In addition to providing a list of adaptation activities, a progress scale (0-No progress to 3- Fully complete) is provided in the tool. Enter a value (using the drop-down menu) next to each mitigation action/associated adaptation action that represents their progress in achieving that strategy. By having the “yes, no, N/A” responses automatically provided next to each mitigation action based on the entries on Page 15, this serves as a reminder to enter “0” no progress for actions that have not been implemented. Even if a mitigation action is implemented, the adaptation action may not have started in which case a “0” would be entered. Ideally, when the tool is repeated, the goal is to improve the agency’s progress for each strategy over time.

The last input is entering any additional adaptation strategies in support of mitigation activities along with their progress value.

Page 17: Monitoring Plan

The “Monitoring Plan” page is meant to document the progress and iterative nature of applying a tool such as CCATT: Mid-Atlantic. Since impacts along with facilities change over time, it is recommended that the agency applies the tool at minimum on a yearly-basis.

Enter the current date (month/year) of completion along with input areas for mid-year and year review dates. The mid-year review is recommended only if there are major changes either in the agency, existing or proposed facilities, or climate change impacts that should be addressed prior to the next yearly review. This includes updates to CCATT: Mid-Atlantic in specific areas for which changes are made. The yearly review, however, is a complete application of CCATT: Mid-
Atlantic, and is highly recommended since the adaptation management process, is iterative. In addition to entering the month/year associated with the mid-year and year reviews, input any major changes to facilities or results found throughout the implementation of the tool.

**Page 18: Summary Report**
The “Summary Report” page is used as an output of the entire CCATT: Mid-Atlantic application. Each page of the tool is included and the entries along with the recommendations are reported in the summary. It is recommended to print the summary report once it is complete and save the information on a yearly basis. This allows for comparisons from year to year.

**Contact**
For questions or comments regarding CCATT: Mid-Atlantic please contact Michelle Oswald at moswald@udel.edu.

**References**


